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INTRODUCTION

The goal of this quick start tutorial is to rapidly introduce users to the core concepts of SpaceNet through
realistic, but notional scenarios. It is organized in two separate scenarios, representing the natural progression
from analysis to abstraction to analysis. A user with no prior experience in SpaceNet should allocate at least
an hour to input and absorb each of the two quick start scenarios — of course much more time could be spent
delving into the various details and trades diverging from the given scenario.

The first quick start scenario focuses solely on the transportation architecture of a proposed lunar mission.
The sole resource that is inspected in great detail is propellant for various propulsive vehicles, and the only
analysis performed is the capability to achieve the required impulsive burns to reach the destination (Lunar

South Pole) with a deliverable mass of cargo, and return with a mass of samples.

The second quick start scenario takes the results from the first, and abstracts the individual impulsive burns
into a flight, which allows the transport of a specified amount of mass and crew to a destination under the
assumption that the flight architecture has been shown to close in previous analysis. Using this abstraction, it
becomes much more feasible to analyze a multi-mission campaign, and the user is introduced to several
methods of demand modeling and the challenge of manifesting demands. The analysis is focused on closing
the logistics loop to the Lunar South Pole and maximizing the exploration capability.

It should be noted that the procurement of data and formatting for compatibility, a large portion of the
creation of SpaceNet scenarios, is completely omitted from this guide. As is with all systems-level analysis, the
results are only as good as the inputs (the garbage-in, garbage-out phenomenon), and the acquisition of
accurate data for complex space systems is always a challenge. Before creating a custom scenario from
scratch, it is highly recommended to read Appendices A and B of the SpaceNet User’s Guide, which
introduce users to the representation of data within SpaceNet and how this structure is expressed via the
database.

Finally, advanced, highly-customized scenarios will inevitably encounter lapses in the SpaceNet data model, at
which point custom programming is required. At this point, the user should reference the SpaceNet source
code and Javadoc for help in this endeavor.
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SCENARIO 1: LUNAR TRANSPORTATION ARCHITECTURE

The first quick-start tutorial scenario is focused on analyzing a proposed transportation architecture for a
return to the moon. This analysis focuses on the propulsive feasibility of transporting a crew of four and a
specified launch mass from Earth to Lunar South Pole.

The analysis is very detailed in terms of required delta-v for propulsive burns, including both OMS (Orbital
Maneuvering System) and RCS (Reaction Control System) capabilities, and for that reason is fairly time-
intensive. For scenarios where the transportation architecture is known to close, it is recommended to use the
concept of flights, where this level of detail is not required (See Scenario 2: Lunar Outpost Architecture).

Database Inputs

For this quick-start tutorial, the required data is already included with the packaged database

quick_start_1.xls. Relevant information includes the following:

1. Nodes
a. KSC (Kennedy Space Center) — Surface node
b. LSP (Lunar South Pole) — Surface node
c. PAC (Pacific Ocean Splash-down) — Surface node
d. LEO (Low-Earth Orbit) — Orbital node
e. LLPO (Low-Lunar Polar Orbit) — Orbital node

a. KSC-LEO (Earth ascent, 1 propulsive burn) — Space edge
b. LEO-LLPO (Trans-Lunar injection, Lunar orbit injection, 4 propulsive burns) — Space edge
c. LLPO-LSP (Lunar descent, 2 propulsive burns) — Space edge
d. LSP-LLPO (Lunar ascent, 2 propulsive burns) — Space edge
e. LLPO-PAC (Trans-Earth injection, 5 propulsive burns) — Space edge
3. Resources
a. PBAN Solid (Solid rocket fuel) — Continuous resource
b. LH2/LOX (Liquid hydrogen/liquid oxygen cryogenic fuel) — Continuous resource
c. MMH/N204 (Hypergolic fuel) — Continuous tesource
4. Elements
a. Ares I First Stage — Propulsive vehicle with OMS capabilities
b. Ares I Upper Stage — Propulsive vehicle with OMS capabilities
c. Orion Service Module (SM) — Propulsive vehicle with OMS/RCS capabilities (one tank)
d. Orion Crew Module (CM) — Propulsive vehicle with RCS capabilities
e. Orion Launch Abort System (LAS) — Carrier element
f. Ares V Solid Rocket Boosters (SRBs) — Propulsive vehicle with OMS capabilities
g. Ares V Core — Propulsive vehicle with OMS capabilities
h. Earth Departure System (EDS) — Propulsive vehicle with OMS capabilities
i.  Altair Descent Module (DM) — Propulsive vehicle with OMS and RCS capabilities
j.  Altair Ascent Module (AM) — Propulsive vehicle with OMS/RCS capabilities (one tank)
k. Notional Cargo — Notional element to represent cargo
l.  Lunar Surface Samples — Element representing samples returned from the lunar surface
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Scenario Creation

The first few steps in creating a SpaceNet scenario include setting global parameters such as the simulation
start date and loading the data from the desired data source. Additional options for simulation performance
and constraints are also available from the Edit > Options menu. Please reference the SpaceNet user’s guide
for details on these additional options.

1. Launch SpaceNet 2.5
2. Select File > New to create a new scenario
3. At the top of the screen, input the following into the scenario header:

e Name: Quick Start Scenario 1

e  Start Date: July 1, 2019

e  (Created By: (Your Name)

e Description: A sample scenario analyzing the transportation feasibility of a lunar mission.
[P spaceNeis N BmEESTan s cenanios &jm—i

Filz Eclit Tools Help

FTH G Cick Start Scenario 1 LWEETETTRT T 2 sample scenario analyzing the transportation feasibilty of

a lunar mis=ion

start Date: NRIENE uone (IS % Reload
Created By: i

||f (&) Netwark [ Ej Missions | - Demands | L) Manifest | Simulstion |
Figure 1. The completed scenario header.

4. 'To set the data source, click the button marked “Edit” near the top of the screen
5. Choose the “SpaceNet 2.5 (Excel)” data source type from the drop-down menu

SpaceNet scenarios use a data source to store information on the network components (nodes and edges),
customizable resources used in demands, and element templates. The Excel-based data source uses several
tabs of a spreadsheet to form a simple database. Note that there is no inherent validation built into Excel, so
data should be checked and validated before using in a scenatio.

A B E D E F G H | ] K L M
. | Al | . hl . hl | . . . - hl iy h . - |

1 id type name body 1 latitude longitude apoapsis periapsis inclination body_2 lp_number description

2 | 1 Surface KSC  Earth 28.6 -80.6 Kennedy Space Center

3 | 2 Surface PAC Earth 35 -117.9 Pacific Ocean Splash-down

4 | 3 Surface LSP  Moon I -89.9! -180 Lunar South Pole

5 | 4 Orbital LEO |Earth 296 296 28.5 Low Earth Orbit

6 | 5 Orbital LLPO Moon 100 100 90 Low Lunar Polar Orbit

7

M 4 » ¥ | nodes ~edges . burns resource_types - elements part_applications E- i
Figure 2. A view of the 'nodes' table in the quick start 1 Excel database.

6. Browse to find and load the quick_start_1.xIs file
7. 1f the data source doesn’t load automatically, check the Nodes, Edges, and Resources and click the
“Load” button
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AR D So e

Type: | Spacehlet 2.5 (Excel)

[vl Edges
[T Instartisted Elements

File Path: ‘UcumerﬂS\Eclipse WorkspacetSpaceet\docsquick_start_1 .xlsl — | Browese...

Update: [y podes
[¥] Resources

Diatar:

B Modes r/ Edges r O Resources rﬂ Elemerts

Type

© Surface

HEC

. Surface

pac

' Surface

LEP

@ Orhital

LEQ

1
2
g
4
g

@ Orhital

LLPO

| ) Add NeWH WY Edit || @ Celete |

Figure 3. The data source dialog after loading data from the quick start 1 database.

8. Click “OK” to return to the Network tab

During the construction of a scenario, if changes are made to the database you must re-load the data source

to update SpaceNet by re-opening the data source dialog window and clicking the “Load” button. Any new

nodes, edges, or resources will be automatically added, but existing values will only be overwritten if the

associated check box is checked. The only exception to this rule is with elements — due to the complex

structure of element data structures and multiple instantiations with potentially different attributes, only

previews of elements are loaded initially. The full data structures for elements are only loaded when initialized

in a Create Elements event. For this reason, there is an additional option to update instantiated elements to

push updates to already-instantiated elements.
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Network Selection

Upon setting the data source, the network should be auto-filtered to match the selected scenario type, a lunar
scenario by default. In this case, all of the nodes and edges will be used in the scenario. Additional
information on specific nodes and edges can be accessed by clicking to select an item.

File Edit Toolz Help

27 SaGENE T BT EHSS TS CEnTarnioN| __J__JL_']

(1 EH Guick Start Scenario 1 [ EETT T H A sattiple scenatio analyzing the transportation Options: dit

feasibility of & lunar mission

Start Date: AR Data Source: ) 1 & Reload
Created By: S iCdl=Cg

4o Network rﬁ}j Missions r - Demands r I..] Manifest r Simulation

Scenatio Type: ‘ Lunar hd
Modes Edges

| Al -

Mame

KsC
PAC
LsF

@ LEO

@ LLFO

EIEIEIE|x] -

Select Al

rhode Detail

Deszelect Al

rBody Dizplay Option:

Metwiork Display Cption:

Size Scaling: 2,’:% Fosition Scaling: 1-5|’:j [Z] Draw Orhital Limits Atitude Scaling: 100',—j Mode Size: 15|j (53

d

I

Size Basis: 15 Postion Basis: 1= [ Inine Moo Made: Alttudle Basis: 150[= Edge Wickh: =
Size Disparity: 10,’:j Posttion Disparity: SD,Cj [ mizpiay Sun [¥] Dravw Black Backgraund

L
Figure 4. A view of the Network Tab overlaying the scenario network on the Earth-Moon system.
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Mission Creation

After setting the network, switch to the Missions Tab. The missions tab is used to define the set of missions
that operate on the scenario network. Although not a strict definition, a mission usually corresponds to one
crew rotation or one transport of supplies.

Each mission is assigned a start date and nodes of reference corresponding to the departure and return (if
necessary) trips. These nodes are used for internal calculations of transit and surface durations. Mission-level
demand models can also be assigned to missions and are introduced in quick start scenario 2. Finally, each
mission has a set of events that are executed to perform mission tasks such as element instantiation,
transportation, and exploration.

1. Click the “Add” button under the missions list to create a new mission
2. Input the following mission information:

e Name: Lunar Sortie
e  Start Date: July 1, 2019
e Departure Trip: From: KSC To: LSP
e Return Trip: From: LSP To: PAC

gjl IWetweark rdr:;"} Wissions r L) Demands |/_|

Marme: |Lunar Sortie |

Start Date: [Jul1, 2019 [=]]
Departure Trip—— rReturn Trip
Fram: ‘ =S | Fratm: ‘ Lsp ™ |

Ta: LSP v| T PaC "’|

Figure 5. The completed mission information.
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First Launch Stack Instantiation

The first events will be an instantiation of the first launch stack (Ares I) at KSC. This will be achieved with
two separate Create Elements events, one to instantiate the launch stack, and the other to instantiate the crew

inside the crew module.

1. First, to instantiate the launch stack, click “Add Event” at the bottom of the screen and choose
o bl

“Create Elements”

2. Add the following elements from the Element Library:

e  Ares I First Stage (Propulsive Vehicle)

e Ares I Upper Stage (Propulsive Vehicle)

o Orion SM

(Propulsive Vehicle)

e Orion CM (Propulsive Vehicle)
e Orion LAS (Carrier)

3. Click “OK” to save the event
4. Next, to add the crew members to the crew module, click “Add Event” and choose “Create
Elements” again
5. Change the “Create in” field from “KSC” to “Lunar | Otion CM”
6. Add four copies of the Crew Member element from the Element Library
7. Click “OK” to save the event
oA G ETENIS) ﬂ‘ L AGTeateHEmeEnS a‘
MName: |Lunar\CrsaiE Elemerts ‘ Mame: |Lunar|CrealeE\emEms |
Mt JoKsC ™ Mode: L HEC ™
Time: D’ﬁ darys Priarity: |1 v Time: D,ﬁ days Priority: | 2 hd
Elemert Library rElement Library
Create in: ‘ " KSC v| Creste i |  Lunar | Orion CM v|
| [a hd | | an -

0 crew Crew

0,000 m*3 Cargo Yolume

Elemenits: ) Lunar | Ares | First Stage
7 Lunar | Ares | Uppet Stage
- Lunar | Orion Sk
- Lunar | Orion Ch
= Lunar | Orion LAS

 Ares Y SRBs (Propulsive Yehicle)

© Ares ¥ Core (Propulsive Yehicle)
EDS (Propulsive Yehicle)

- Altait DM (Propulsive Yehicle)

) Altair A (Propulsive Vehicle)

& Crewy Member (Crevw Member)

Motional Cargo (Element)

 Lunar Surface Samples (Element)

2 OK | g Cancel

00/100.0kg Cargo Mass

Crewy

Cargo Volume

' Ares | First Stage (Propulsive Vehicle)
VAres | Upper Stage (Propulsive Vehicle)
! Orion SM (Propulsive Yehicle)

& Lunar | Crew Member B
& Lunar | Crew Member C

Elements: E £ Lunar | Crew Member &
ng Lunar | Crew Member D

1 Orion CM (Propulsive Yehicle)

=0 Orion LAS (Carrier)
Ares ¥ SRBs (Propulsive Vehicle)
Ares ¥ Core (Propulsive Yehicle)
EDS (Propulsive Vehiclz)

! Aftair D (Propulsive Yehicle)
Altair AM (Propulsive Yehicle)

! Mational Cargo (Element)
' Lunar Surface Samples (Element)

Remaove

| g OK | ‘ ~.g Cancel

Figure 6. The completed event to initialize the Ares I
launch stack.

Figure 7. The completed event to create the crew in
the crew module.
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First Launch

After instantiating the launch stack at KSC, we will immediately launch it into orbit at LEO using a space
transport.

1. Click “Add Event” and choose “Space Transport”
2. Check all five elements to be included in the launch stack

Provide the burn/stage sequence to achieve the required 9500 m/s delta-v by selecting the proper
elements and clicking the “Burn” and “Stage” buttons:

e Burn Ares I First Stage
e Stage Ares | First Stage
e Stage Orion LAS

e Burn Ares I Upper Stage

e Stage Ares I Upper Stage
4. Press the “OK” button to save the event

E by paceN ransporit ﬂ‘

Mame: |Lur|ar | Space Transport ‘

Morde: KsC w
Tirme: D,ﬂ darys Priority: | 3 Vl
Trajectory: | / KSCLEQ ™

Destination: LEC
Duration: 025 days

Elements: vl Lurar | Ares | First Stage

LLPO

[l (2 Lurar | Orion CM
[Vl &0 Lunar | Crion LAS
[vi Lunar | Oricn Sk

® Burn|| ® Stage /
[ Burn 1 (ONt= Defta-v: E

—
Stack Mass: 215750 ky
SEqUENCE:

@ [B]Lunar | Ares | First Stage _— -
® [S]Lunar | Ares | First Stage -
® [S]Lunar | Orion LAS
@
®

[B] Lunar | Ares | Upper Stage —
[5] Lunar | Ares | Upper Stage
KsC

2 OK |,‘_‘3CEHCE| 18:00 18:20 18:40 1900 19:20 19:40 20:00 20:20 20:40 21:00 21:20 2140 22:00 22:20 22:40 23:00 23:20 23:40 00:00

Date
Figure 8. The completed event to Figure 9. After creating the first space transport, the mission bat chart
launch the Ares I stack.

illustrates the transport of the launch stack from KSC to LEO.
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Second Launch Stack Instantiation

Now that the Orion vehicles and crew are in orbit, we will instantiate the second launch stack (Ares V),
including the Altair vehicles, at KSC. Similar to adding crew, this will also require two separate events in order
to correctly represent a notional cargo element.

Change the Time to

el o

1.0

e Ares V SRBs (Propulsive Vehicle)
e Ares V Core (Propulsive Vehicle)
e EDS (Propulsive Vehicle)

e Altair DM (Propulsive Vehicle)

e Altair AM (Propulsive Vehicle)

Add the following elements from the Element Library:

First, to instantiate the launch stack, click “Add Event” and choose “Create Elements”
Change the Node to KSC

5. Click “OK” to save the event
6. Next, to add the cargo element, click “Add Event” and choose “Create Elements” again
7. Change the “Create in” field from “KSC” to “Lunar | Altair DM”
8. Add a copy of the “Notional Cargo” element from the element library
9. Click “OK?” to save the event
~|reateNiements a1 > AGreataNerments a‘
Mame: |Lunar | Creste Elements ‘ hlame: ‘Lunar | Creste Elements |
Mode: | © KSC ™ Mode: “KEC W™
Time: 1% days Priority: [1 - Time: 1,% days Priarity: |2 -
rElemert Library rEemert Library ————————————
Create in; | -+ KsC '| Create in ‘ 7 Lunar | Attair Dn v|
| [ hd | [ -
Cargo Mass Cargo Mass
) Ares | First Stage (Propulsive Yehicle) | Ares | First Stage (Propulsive Vehicle)
Catgn Volume 3 . Catgo Volume . )
' Ares | Upper Stage (Propulsive Yehicle) ) Ares | Upper Stage (Propulsive Yehicle)
Cres | Orion SM (Propulsive Yehicle) Crews ~ Crion St (Propulsive Yehicls)
Elements: _ Lunar | Ares ¥ SRBs ) Orion CM (Propulsive Yehicle) Elements:

T Lunsr | Ares Y Core
) Lunsr |[EDS
' Lunar | Attair DR
VLungr | Alair AWM

(S Orion LAS (Carrier)

. (PH )
& Crew Member (Crew Member)
) Motional Cargo (Element)

' Lunar Surface Samples (Element)

Remove

S OK || .d Cancal

— L Lunar | Motional Cargo

. Orion CM (Propulzive Wehicle)
(=0 Orion LAS (Carrier)
) Ares W SREBs (Propulsive Yehicle)
JAres W Core (Propulsive Yehicle)
./ EDS (Propulsive “Wehicle)
) Attair DM (Propulsive Vehicle)
- Altair AM (Propulsive Yehicls)
& Cresw Member (Crevw Member)

tment)
) Lunar Surface Samples (Element)

| o2 Ok | ‘ g Cancel

Figure 10. Completed event

to initialize the Ares V

launch stack.

Figure 11. Completed event to create the notional
cargo inside the Altair descent module.
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Second Launch

Just as in the first launch, we will immediately launch the second stack into orbit at LEO using a space
transport.

1. Click “Add Event” and choose “Space Transport”
2. Check all five elements to be included in the launch stack

Provide the burn/stage sequence to achieve the required 9500 m/s delta-v by selecting the proper
elements and clicking the “Burn” and “Stage” buttons:

e  Burn Ares V SRBs
e Stage Ares V SRBs
e  Burn Ares V Core
e Stage Ares V Core
e  Burn EDS
4. Press the “OK” button to save the event

24 SPHCEN NENSPOTi ﬂ‘

Mame: ‘Lunar | Space Transport |
LsP

Mole: KsC ¥

Time: ‘uﬁ days Priority: |3 V‘

Trajectary: ‘ / KSC-LED ¥

Destination: LEQ
Duration: 0.25 days

LLPO

Elements: [¥] 0 Lumar | Attair A
[v] Lunar | &ltair D
[¥] 0 Lunar | Ares W Core
[v] Lunar | Ares ¥ SREs
2
v . Lunar | EDS LEO

[ Bun 1 (OMS; Detta-y:

Stack Mass: 1852856 ko
Sequence:

© [B] Lunar | &res ' SREs
@ [S]Lunar | Ares ¥ SREs /’
@ [B]Lunar | Ares v Core

® [Z]Lunar | Ares v Core
© [B] Lunar | EDS

| & Cancel 18:00 2000 22:00 00:00 0200 0400 06:00 08:00 10:00 12:00 1400 16:00 18:00 20:00 22:00 00:00
Date
Figure 12. Completed event to Figure 13. The mission bat chart illustrates the dual launches to LEO.
launch the Ares V stack.
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Trans-Lunar Injection, Lunar Orbit Injection
Now that vehicles from both launch stacks are in low Earth orbit, they can be coupled in future events such

as the lunar orbit injection transport. Although not presented in this scenario, if you want to model proximity
operations such as orbit circularization, docking, or undocking, you can use individual “Propulsive Burn”

events.

1. Click “Add Event” and choose “Space Transport”

2. Change the Time to 2.0
Check all five elements (Altair AM, Altair DM, EDS, Orion CM, and Orion SM) to be included in

the launch stack
Provide the burn/stage sequence for the first burn (3150 m/s, Trans-Lunar Injection):

e Burn EDS

e Stage EDS
Click “Butn 2 (RCS)” and provide the burn/stage sequence (2 m/s, mid-coutse cotrections):

e Burn Altair DM
Click “Burn 3 (RCS)” and provide the burn/stage sequence (2 m/s, mid-coutse cotrections):

e Burn Altair DM
Click “Burn 4 (OMS)” and provide the burn/stage sequence (950 m/s, Lunar Orbit Injection):

e Burn Altair DM
8. DPress the “OK” button to save the event

%]

= SPECEN PR POl
|

Mame: |Lunar | Space Transport
LsP

Noce: @ LEo0 -
Time 2 days Priority: [1 |
Trajectory: ‘ /" LEQ-LLPD ¥

=

Destination: LLPO
Duration: 4.0 days LLFO
_—
——

Lunar | Attair At
Lunar | Attsir D i
Lunar | EDS
Lunar | Qrion Cht
Lurear | Orion Skt LEO
/ X
|

Bum 1 (OMS)  Detia-v! 3150.0/3150.0 mis | |
g“’" g (:Z:) Stack Mass: 654000 kg oas I.‘ I'
ES::4((0MS)) Seauence: [ o (5] Lunar | EDS [ |
® [S]Lunar [EDS { |

| ]

&-Jul B-Jul T-dul 8-Jul

4dul

‘ 1 Cancel Sl _—

Figure 14. Completed event to Figure 15. The mission bat chart illustrates the transport of the Altair
perform the TLI/LOI transpott. and Orion vehicles to LLPO.

Elemerts:

&} ]
[LUNLUNLUNLUNLY
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Lunar Descent

Now that the vehicles are in lunar otrbit, we can move the crew from the Orion to the Altair, which will be
used in the descent to the lunar surface.

1. Click “Add Event” and choose “Move Elements”
2. Set the “Move to” location to the Altair AM
3. Check the four crew members (currently in the Orion CM)
4. Click “OK to save the event
|~ AMoyEEIEments m‘
Marme: |Lunar | Move Elements |
Mocle: m
Tirne: Ij% days  Priority: |1 -
Mionve to: ‘ O Lurar | Attair A - |
| 0.0 /4000 ky | Cargo Mass
Cargo Walume
Cre Cresiy
Eletnents: LT - Lunar | Motional Carga -]
[ - Lunar | Qrion Ch
[v] & Lunar | Crevy Member &
[ & Lunar | Crewy Member B
[v] & Lunar | Crewe Member C
%l .=, Lunar | Cresw Member D
[ - Lunar | Orion St -
g Cancel
Figure 16. Completed event to move the crew to the Altair vehicle.
5. Click “Add Event” and choose “Space Transport”
6. Change the Time to 7.0
7. Select the LLPO-LSP trajectory
8. Check the Altair elements (Altair AM, Altair DM) to be included in the transport stack
9. Provide the burn/stage sequence for the first burn (2030 m/s):

e Burn Altair DM

10. Click “Burn 2 (RCS)” and provide the burn/stage sequence (11 m/s):
e Burn Altair DM

11. Press the “OK” button to save the event

SpaceNet 2.5r2 Quick Start Tutorial Page 14 of 43
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= SpacelrEmspoTli
Mame: |Lunar|5pace Tranzport ‘

Mode: | @ LLPO ¥
Time: ?,ﬁ days
Trajectory: |/ LLPOLSP *

Destination: LSP
Duration: 0.5 days

[ 0 Lunar | Altair &0
o e
[ ©7 Lunar | Orion €M
[0 7 Lunar | Grion St

-

Priority: |2

Elemerts:

Defta-v:

Stack Mass: 198099 ky
@ [B] Lunar | Aftair DM

[ Burn 1 (OMS:

Burn 2 (RCS)

Sequence:

Clear

LLPO

B-Jul

Figure 17. The completed event to
perform the descent.

T-dul 2-Jul

8-Jul

10-Jul

3-Jul 4dul S-Jul

Date

Altair vehicle to LSP.

Quick Start Tutorial

Figure 18. The mission bat chart illustrates the lunar descent of the
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Exploration

Now that the crew has reached the lunar surface, we can send them on an exploration, and create a notional
element to represent returnable samples. The exploration of the lunar surface will be accomplished with a
Crewed Exploration event, which is used to schedule a set number of EVAs. Although not presented in this
scenario, individual EVAs can also be scheduled with Crewed EVA events.

Click “Add Event” and choose “Crewed Exploration”
Set the duration to 7.0 days

Set the number of EVAs to 5 per week

Select the Altair AM as the Crew Habitat

Check two of the four crew members for EVA

Click “OK” to save the event

AR

- 2AGrewet! EEployation a‘

Mame: |Lunar|Crewed Exploration |
Maocde: S Lsp W
Time: ?.Slﬁ days Priority: |1
Duration: I:% days | 2 \GreaiaEiEments a‘
= |

Mumber Bv Az 5”::4 per week Iame: |Lunar | Create Elsments ‘

A -
E% A Duration: g j hours Node: Lsp

& Lurar | Crevy Member A
& Lunar | Crevy Member B
& Lunar | Crewy Member C
& Lunar | Crevy Member 0

rElement Libraty
Create in: | Lunar | Akair A0 hd |

‘ [2n -
Cargo hass

| Ares | First Stage (Propulsive Vehicle)

Cargo Yolume N .
| Ares | Upper Stage (Propulsive Yehicle)

S Lunar | Attsir D - Crewy 1 (rion SM (Propulsive Yehicle)
Crewe Evas Crew Membar BV Siate Elemerts: | — (") Lunar | Lunar Surface Samples ED Zr!on el (Propu.lswe “ehicle)
rion LAS (Carrier)
@ & Lunar | Crewe Mem... I Ares W SREs (Propulsive Vehicle)
) Ares W Core (Propulsive Yehicle)
[ Lunar | Crew Mem... ) EDE (Propulsive YWehicle)
D |& Lunar | Crew Mem. .. | | Attair DM (Propulsive “ehicle)

O Aftsir A6 (Propulsive Vehicle)

Add| Demancs:

| | | . & Crewy Member (Crew Member)
Type Resource Amourt Units ) Notionsl Cargo (Element)

Sl

g Cancel g Ok ‘ .4 Cancel

Figure 19. The completed event to schedule the Figure 20. The completed event to add notional surface
surface EVAs with two crew members. samples to the Altair vehicle.

7. Next, to create the surface samples for return, click “Add Event” and choose “Create Elements”
8. Set the “Create in” field to Altair AM

9. Add a copy of the Lunar Surface Samples from the element library

10. Click “OK” to save the event
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r S paceNet sy S S MK arliScenanoy a@@

File Edit Tools Help

[[FT O Cick Start Scenario 1 EETE TV Bl & sample scenario analyzing the transportation

feaszibilty of & lunar mission

start Date: [RRIEE]
Created By: EFEWECREAL=ST

r @ Metwork rl'i-:ﬁ Missions r L) Demands r/ L Manifest r Simulztion

Iame: ‘Lunar Sortie |

Start Date: |Jul 1, 2019 =]

Departure Trip Return Trip LSP o
From: | o oKsC W | From: | SLsR W ‘
To: | S LEp v | To: | 2 PAC W ‘ |
{
Demand Models: J'II
| | LLFO L
‘ CL Add Model | of Edt || B Remove
Events:
@ Evert Natme e
@ 1 |Lunar | Creste Elements
@ 2 |Lunar | Creste Elements
Z‘? 3 |Lurar | Space Transport
@ 1 |Lunar | Creste Elements |
@ 2 |Lurar | Creste Elements | |
E;? 3 |Lunar | Space Transport i | |
E:j' 1 |Lunar | Space Tranzport |
= 1 |Lunar | Move Elements | |
E 2 |Lunar | Space Transport |
- 1 |Lunar | Crevwed Explorat
® 1
KSC

‘ i Add Evert || -, Edit || . Remove |

3-Jul S-Jul S-Jul B-Jul 7-dul 8-Jul g-Jul 10-Jul 11-dul 12-Jul 13-Jul 14dul 158-Jul 18-Jul 17-Jul
@ Save Date

[
Figure 21. A view of the missions tab after completing the surface exploration and adding the samples.
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Lunar Ascent

After the surface exploration, the crew and the ascent module perform a space transport to rendezvous with

the command module and service module in lunar orbit.

1. Click “Add Event” and choose “Space Transport”
2. Check the Altair AM to be included in the launch stack
3. Provide the burn/stage sequence for the first burn (1875 m/s):

e Burn Altair AM

4. Click “Burn 2 (RCS)” and provide the burn/stage sequence (31 m/s):

e Burn Altair AM
5. Click “OK” to save the event

%]
Mame: |Lunar|5pace Transport |
Mace: | o LSP W

Time: 14 Slﬁ days
Trajectory: | / LEP-LLPO ¥

Destination: LLPC
Duration: 0.5 days

i il
[71 20 Lunar | Altsir DM

Iransponi

Priotity: |2 hd |

Elemerts:

Burn 1 (OMS) Detta-4: 0730 mis
[LBurn 2(RES) | ooy Mass: 35395 ke

Sequence:

@ [B] Lurar | Altair AM

g Ok | g Cancel

Figure 22. The completed event to
launch the Altair ascent vehicle.

LLPO . i '
LEO ;
PAC || ||
]
|
Ksc i
3Jul Adul Sdul GJul  Tdul B-dul  Sdul 10dul Adul AZdul A3dul 14dul A5dul 16-dul A7-dul 18-d

Date

Figure 23. The mission bat chart illustrates the ascent of the Altair to

LLPO
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Trans-Earth Injection

Finally, to complete our scenatio, the crew rejoins the Orion vehicle in lunar orbit, and returns to Earth.

el o

e AN

11.

12.

13.

14.

15.

Click “Add Event” and choose “Move Elements”
Set the “Move to” location to the Orion CM

Check the four crew members and the Lunar Surface Samples (currently in the Altair AM)

Click “OK” to save the event

Ay EIE EmEntE ﬂ

Marme: |Lunar | Miowe Elements |

Mode: | @ LLPO W
Tirme: 15l':;| days  Priority: |1 -
Mave ta: || Lunar | Orion Chl i ||

0.000 J 0,000 m*3 Cargo Yolume

Cresy

Blements: |21 7] (0 Lunar | Attair AW -
v & Lunar | Crese Member &,

v & Lunar | Crev Member B

v & Lunar | Crev Member C

v & Lunar | Crev Member D

[v] 0 Lunar | Lunar Surface Samples

— [ 0 Lunar | Crian Ch

-

. Cancel

Figure 24. The completed event to move the crew and samples to the crew module.

Click “Add Event” and choose “Space Transport”
Set the Time to 16.0
Select the “LLPO-PAC” trajectory
Check the Orion CM, and Orion SM to be included in the transport stack
Provide the burn/stage sequence for the first burn (612.3 m/s):
e Burn Orion SM
Provide the burn/stage sequence for the second burn (276.5 m/s):
e Burn Orion SM
Provide the burn/stage sequence for the third burn (333.6 m/s):
e Burn Orion SM
Provide the burn/stage sequence for the fourth burn (3.2 m/s):
e Burn Orion SM
Provide the burn/stage sequence for the fifth burn (3.2 m/s):
e Burn Orion SM
Provide the burn/stage sequence for the sixth burn (5.0 m/s):
e Stage Orion SM
e Burn Orion CM
Click “OK” to save the event
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E;;ﬁ

ICEN ranEpon

gl

Mame: |Lunar | Space Transpon|

Mode: | @ LLPO ¥
Time: ﬂﬁ,ﬁ days

Priorty: |2 b ‘

Trajectory: ‘ /" LLPO-PAC *

Destination: PAC
Duration: 4.0 days

Elements: [Z1 2 Lunar | Aair A0
[¥l 0 Lunar | Orion Cha
¥ £ Lunar | Orion Sh

Burn 1 (OMS)
Burn 2 (OMS)
Burn 3 (OMS)

Defta-v.
Stack Mass: 86603 ko

SEOUENCE. | @ [S] Lunar | Orion S

@ [B] Lunar | Orion Chl

Burn 4 (RCS)
Burn 5 (RCS)
Burn 6 (RCS)

Clear

‘ .4 Cancel

Figure 25. The completed event to
return the Orion vehicle to Earth.

LSP

LLPO

4Jul B-Jul a-Jul 10-Jul 12-Jul

Date
Figure 26. The mission bat chart illustrates the transport back to the
PAC splashdown.

14-Jul 16-Jul 18-Jul 20-Jul 22-Jul
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Simulation and Analysis

The mission creation process heavily relies on pre-simulation to check for error conditions throughout the
scenario creating process. Since we were able to create this mission without any errors, the transportation
architecture closes.

For more detailed analysis, however, we can run a simulation and inspect the levels of propellant throughout
the scenario. Note that this scenario does not inspect demand feasibility, so there are no demands to view in
the Demands tab, nor anything to pack and manifest in the Manifest tab.

Click “Save” to save this mission
Switch to the Simulation Tab
Click the “Simulate” button to run the simulation

b=

Under the “Network History” tab, press the play button to run a basic network animation. Pause the
animation near July 8, 2019 and select an element in the right-hand part of the screen, to inspect its

remaining propellant, cargo capacity, and other information.

r Metwork History r Measures History r Location Histary r Element History |
T}

I 1t 1

- .

HEEDEE

|« |
1015

1 1 1 | 1 1
Jult, 2019 Jul's, 2019 Julg, 209 Jul13, 2018 Jul?, 2018 Jul21, 2018

Frames per second:

|1 Constant Time per Frame
Elemenit Details

Drate: Jul 8, 2019 15:05
Relative Time: 6.75
Elements:
B @ LLPO
= Lunar | &lair &k
8\ Lunar | Creve Member A
}S« Lunar | Crevw Member B
8\ Lunar | Crev Member C
{'3 Lunar | Cresw Member O
=] Lnar 11
Lunar | Motional Cargo
Lunar | Crion Ch
Lunar | Crion St

State:
Mazs: 250401 kg
Wolume: 0.0 m"3

Cargo Mass:
Cargo Volume:
Crew:

WS Propellant:

RCS Propellant:

Figure 27. After simulation, the Network History tab provides a basic animation for the scenario.

5. Switch to the “Element History” tab, and select the “Altair DM” element. By toggling the visible
classes of supply to only display COS 1 (Propellants and Fuels), you can track the remaining
propellant throughout the scenario.

6. Right-click the chart and choose “Save as...” to save the chart as a .PNG formatted image. This
capability is inherent in all charts within SpaceNet.
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rNetwork Histary r Measures History r Location History rEIament Histary
A |Chart Options
26,000 4
25,000 Elzment: Lunar | Altair O ™
EZ:EEE Fiter Clazzes of Supply
22,000 : Propellants and Fuels
. ] coS2: Crew Provisions
: ] COS3: Crew Operations
el [ coS 4 Maintenance and Upke...
fEin [ coss: Stoweage and Restraint
18.000 O cose Exploration and Resea...
17.000 [[] COS 7:Waste and Disposal
16,000 [JJ CoS & Habitation and Infrasir ...
= 15,000 [ cosa Transportation and Ca
= 14,000 [ cos 1o Miscelaneous
® 13,000
g 12,000
11,000
10,000
2,000
8,000
7.000
6,000
5,000
4,000
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2,000
1.000
o H H
4Jul 6-Jul 8-Jul 10-Jul 12-Jul 14-Jul 16-Jul 8Jul 20-Jul 22-Jul Sl ol | || et A
Date
[0 Enearize patal

Figure 28. The Element History tab allows a visualization of resource levels through the scenario, in this case
propellant in the descent module.
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SCENARIO 2: LUNAR OUTPOST ARCHITECTURE

Using the results of the first scenario, the second quick-start scenario abstracts the transports from the Earth
to the Lunar South Pole to a single flight, and the same for the return trip. It uses the assumption that the
transportation architecture is known to close for a delivery payload of 500 kilograms and a return payload of
100 kilograms for a crew of four to simplify the build-up of a long-duration lunar outpost.

Also included in this analysis is the knowledge that cargo flights can deliver 12,000 kilograms to the lunar
surface — the results from which a separate analysis similar to that from the previous scenario has already
been performed.

The goal of this next level of analysis is analyzing the surface feasibility, including demands from the crew
members, demands for spare parts, and the supply chain network used for resupply. If the scenatio does

indeed close, then we then can seek to evaluate the scenario based on one or several Measures of Effectiveness.

Database Inputs

For this quick-start tutorial, the required data is already included with the packaged database
quick_start_2.xls. Relevant information includes the following:

1. Nodes
a. KSC (Kennedy Space Center) — Surface node
b. LSP (Lunar South Pole) — Surface node
c. PAC (Pacific Ocean Splash-down) — Surface node

a. Crewed Delivery — Flight edge

b. Crewed Return — Flight edge

c. Cargo Delivery — Flight edge
3. Resources

a. Habitat Spare — Discrete resource for notional habitat spares

b. Power Supply Spare — Discrete resource for notional power supply spares
4. Elements

a. Crewed Lander — Carrier representing transportation architecture delivering crew and

minimal cargo

b. Crewed Return Capsule — Carrier representing transportation architecture returning crew
and minimal cargo
Cargo Lander — Carrier representing transportation architecture delivering significant cargo
Crew Member — Crew member
Crew Habitat — Carrier that crew use as an outpost habitat

m o oo

Power Supply Unit — Element that supplies power to the habitat
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Scenario Creation

As in quick start scenario 1, we will first set some global parameters for the scenatio, including the data
source.

1. Launch SpaceNet 2.5
2. Select File > New to create a new scenario
3. At the top of the screen, input the following into the scenario header:
e Name: Quick Start Scenario 2
e  Start Date: July 1, 2019
e (Created By: (Your Name)
e Description: A sample scenario analyzing the feasibility of a lunar outpost.

e Scenario Type: Lunar

[E SpaceNet 2. || Quick Start Scenario, 2 aam—‘

Filz Eclit Tools Help

[[FTOTE Cick Start Scenario 2 [ EETH T Bl & sample scneario analyzing the feasibilty of & lunar Options: [ESEN=IT

outpost.

Start Date: AFREE] Data Source; . Mone (R @ Reload
Las

Created By: [REERENE AT

1 Dec, 15 2010 S:09 PM EST

||r (&) Metwork | &7 Missions [ o Demands | L Manifest [ Simulstion |
Figure 29. The completed scenario header.

To set the data source, click the button marked “Edit” near the top of the screen

Choose the “SpaceNet 2.5 (Excel)” data source type from the drop-down menu

Browse to find and load the quick_start_2.xIs file

If the data source doesn’t load automatically, check the Nodes, Edges, and Resources and click the
“Load” button

Neoo,os

A EESoTCe m-‘
Type: |§ Spacefet 2.5 (Excel)l v|
File Path: |0c:uments\Ec:Iipse WDrkspac:e\SpaceNet\docs\quick_startJ.xIS| l_ b Erowse..|
Updste: (o] poges [¥] Edges
[V Rezources [ Instantisted Elements

Eat ® podes r/ Edges r “ Resources rﬂ Elements
1D Type Hame
1] = Surface KSC
2| & Surface PAC
3| @ Surface LSP

|@Addmew|| y°Ed'rl|| @ Delete

Figure 30. The data source dialog after loading the data from the quick start 2 database.

8. Click “OK?” to return to the Network tab
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Network Selection

Upon setting the data source, the network should auto-filter to the correct scenario type. In this case, all of
the nodes and edges will be used in the scenario. Note also that this scenario uses flight edges (yellow) instead
of space edges (red) and no intermediate nodes between the Earth and the Moon. This abstraction will allow

us to create missions much faster.

-2 spaceNets 2. ol Qujck Start Scenario 2 __J__Jd
File Eo l= Help
/ Name: SRV (00 B & sample scneario analyzing the feasibilty of & lunar options: [EEERS
. Start Date: Data Source: 2 qui -
Cresteaty: . P st

4 Metwrork [’L'”-}} Mizsions r - Demands r/ I..] Manifest r Simulation

Scenatio Type: ‘ Lunsr hd
Modes Edges

| al -
L Mame
V| o ksc
[vi PAC
i|- Lsp

| Select Al | Dezelect Al

rMode Detail

rBody Display Option: Metweark Display Cption;

Size Scaling: 2 Position Scaling: 1.5,':j [ Drawy Orhoitsl Limits Altitude Scaling: 100',—j Mode Size: 18',7j o
Pasition Basis: 1,':j [¥] Inline Moon Made: Altitucle: Basis: 150||—j Edlge Wicith: 1 ||—j pix

!

Size Baziz: 1 j
Size Disparity: 10Pj Position Disparity: SDFj [ misplay Sun [¥] Draw Black Backgraund

L
Figure 31. A view of the Network Tab overlaying the scenario network on the Earth Moon system.
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Mission Creation

After setting the network, switch to the Missions Tab. In this scenario, we will be creating four missions

instead of just one. An important difference is that any non-reusable mission elements must be removed from
the simulation. For example, after the crew returns to Earth, they should be removed from the simulation to
prevent demands from being generated in the Pacific Ocean.

Mission 1: Automated Check-out

The first mission will deploy an unmanned lander and return capsule to the lunar surface in preparation for
future crewed missions. Taking advantage of the abstracted transportation architecture with flight transports,
this mission will only require two events.

—_

2. Input the following mission information:

e Name:
e  Start Date:

e Departure Trip:

Automated Check-out Mission
July 1, 2019
From: KSC

To: LSP

Click the “Add” button under the missions list to create a new mission.

2. To instantiate the flight vehicles, click “Add Event” at the bottom of the screen and choose “Create

Elements”

3. Add the following elements from the Element Library:

e Crewed Lander (Carrier)

e Crewed Return Capsule (Carrier)
4. Click “OK” to save the event

S lreateNEBents

[arme: |Au10m | Create Elements

Mocle: S HEC W™

0 crew | Cresy

S eturn
=] Cargo Lander (Carriet)

Time: D,ﬁ days Priarity: |1 hd
rElement Library
Create in | o REC '|
| |AII -
| 150000 kg | Cargo Mass
I 0.000 m*3 | Cargo Yolume

Elements: [n.—;'a Autom | Crevwed Lander
=0 Autom | Creswed Return Capsule

& Cresw Member [Crew Member)
= Crew Habitst [Carrier)
! Powver Supply Unit (Element)

| g OK || . Cancel

Figure 32. The completed event to instantiate the flight elements.

5. Next, to transport the vehicles to the Lunar South Pole, click “Add Event” and choose “Flight

Transport”

6. Choose the “Crewed Delivery” flight, and check both the lander and return capsule

SpaceNet 2.5r2
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7. Click “OK” to save the event
8. Click “Save” to save the mission

ﬂ‘l

27 F e Tras uur

Mame: |Aut0m | Flight Transport |

Macle: 4 KsSC ™
Time: Dl':;l days  Priority: |2 V|

Flight; | /" Crewved Delivery 'l

Destination: LSP
Durstion: 7.5 days

0075000 ky

Capacity: | | (Cargo)

| 074 cress | [CreEw)

Elemerts: |: [¥] &9 Autom | Creveed Lander
[¥] S0 sutom | Crevved Return Capsule

.3 Cancel

Figure 33. The completed event to
perform the flight transport.

Process Bat Chart r Element Bat Chart

1-dul 2-Jul 3-dul Jul S-dul
Date

B-Jul 7-Jul 8-Jul

- a

[Chart Options —————————

0] Filter Missions
[Vl Automated Check-out Mission (7/1118)

Select Al | | Deselect All

g Fiter Evert Types [ |
[Vl & Creste Elemerts -
[v] &) sdd Resources

[¥] = Move Elements

[v] = Transter Resources
[Vl @ Remave Elements
[v] 58 Reconfigure Element
[V 58 Recontigure Group
[v] & Demand Resources
[v] 4 Propulsive Burn

[C] Draw Elements Waiting (Mull Process)

Select Al | | Deselect Al

Figure 34. The scenario bat chart shows the transport to LSP in the

first mission.
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Mission 2: 7-Day Crewed Mission

The second mission delivers a crew of four to the surface. As in quick start 1, the launch stack and the crew
are created in separate events. Like the previous mission, a flight is used to transport the crew to the lunar
surface. While on the surface, the crew will participate in scheduled EVAs throughout the mission duration

before moving to the return module before being transported back to Earth. Finally, the return capsule and
the crew are removed from the simulation.

1.
2.

Click the “Add” button under the missions list to create a new mission.

Input the following:
e Name:
e Start Date:
e Departure Trip:
e  Return Trip:

7-Day Surface Exploration

December 1, 2019
From: KSC To: LSP
From: LSP To: PAC

3. Click “Add Event” at the bottom of the screen and choose “Create Elements”
4. Add the following elements from the Element Library:

e Crewed Lander (Carrier)

e Crewed Return Capsule (Carrier)

< (13 2»
5. Click “OK” to save the event
—\GreatelH : 1 > \Greate : 1
- Lredle L!EJHEJJ[J SLTEdLE) E‘EJIIEJJ!;
Marme: [7-Day | Creats Elements | Mame: [7-Day | Creste Elemerts |
Mode: PKEC ™ Moche: KEC ¥
Time: 0= days Priority: [1 ¥ Titme: 0= days Prirty: (2w
rElement Library: rElement Library
Create i ‘ < HSC hd | Create in; |l._:h 7-Day | Creswed Lander A |
| [ ~ ‘ [ -
150000 kg Cargo Mass 0074000 kg Cargo Mass

Elements:

0.000 m*3 Cargo Yolume

l:l._:h 7-Day | Cresved Lander
=] 7-Day | Cresved Return Capsule

= Cargo Lander (Carrier)
& Crevy Member (Crew Member)
=0 Crew Habitat (Carrier)

' Powver Supply Unit (Element)

8 Remave

| g OK | -5 Cancel

Cargo YVolume

Crew

& 7-Day | Cres Member B
& 7-Day | Crew Member C

Elements: E £\ 7_Day | Crew Member A
& T-Day | Cresw Member D

& Creswed Landsy (Carrier)
&4 Crewed Return Capsule (Carrier)

&4 Crew Habitst (Carrier)
Power Supply Unit (Element)

2 O | | ~ Cancel

Figure 35. The completed event to instantiate the

Figure 36. The completed event to create the four
crew members in the lander vehicle.

Click “Add Event” and choose “Create Elements” again
Change the “Create in” field from “KSC” to “7-Day | Crewed Lander”
Add four copies of the Crew Member element from the Element Library

Click “Add Event” and choose “Flight Transport”
Choose the “Crewed Delivery” flight and check both the lander and return capsule

flight vehicles.

6.

7.

8.

9. Click “OK” to save the event
10.

11.

12. Click “OK” to save the event
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B HY R 3 ‘
= FHE Tz nart a
Marme: |?’-Day | Flight Transport |

LsP
Mode: 4 KEC W
Time: D,:—j days Priority: |3

Fligghit: | /' Creneved Delivery v|

Destination: LSP
Duration: 7.5 days

Capacty: | 0.0 /5000 kg | (Cargo) PAC

[Crew)

Elements: [v] & 7-Day | Crevved Lander
v 4% T-Day | Crese Member &
v & T-Davy | Cresy Member B
v & T-Davy | Cresy Member C
v &, T-Dary | Creswe Member D
v & 7-Dary | Creswved Return Capsule

. Cancel 1-Dec 2.Dsc 3-Dec 4Dec 5-Dec 6-Dec 7-Dec 8-Dec

Date
Figure 37. The completed event to Figure 38. The mission bat chart illustrates the flight transport

transport the crew. from KSC to LSP.

13. Click “Add Event” and choose “Crewed Exploration”
14. Set the Duration to 7 days

15. Set the Number of EVAs to 5 per week

16. Set the Crew Habitat to the “Crewed Lander”

17. Check two of the crew members to participate in the EVA and click “OK” to save the event

| AGreweL Euluraiilug a‘
Mame: |7-Day|crewad Explaration ‘
Mode: | = LSP W
Time: 7.5,§ days Priority: | 1 '\

Duration: ?I,—j clarys
Mumber BV As: E% per week
E% haors:

=] Lander

&, 7-Day | Crew Member &
& 7-Dary | Crew Member B
&, T-Day | Cresw Member C BRC

EV& Duratian:

Crewy Location:

&, 7-Day | Creew Member D
=] T-Day | Crewved Return Capsule

Crew: [ Evaz | CrewMember | BV, State |
[v] |5 7-Day | Crew Mem...
[ 7-Day | Crew Mem...
[ |& T-Day | Crew Mem... |

" . ksc{| m
Add'l Demancs: Type | Resource | Amount | Units:

sl

4 canced 1Dec 2Des 3Dec 4Dec 5Dec BDec 7-Des 8Dec O-Dec 10Dec 11Dec 12Dec 13-Dec 14Dec 15Dec

Date
Figure 39. The completed event to Figure 40. The mission bat chart illustrating the crewed surface
perform the crewed exploration. exploration.

18. Click “Add Event” and choose “Move Elements”
19. Set the “Move to” field to “7-Day | Crewed Return Capsule”
20. Check the four crew members and click “OK” to save the event
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> ovElE Bment s a

Mame: |?-Day | Move Elements |

Miode: 2 LSp ™
Time; 14.5,'%: days  Priority: |1 hd
Move to; | &4 T-Day | Creweed Return Capsule hd |

| 0.0/100.0 ky

| Cargo Mass

Cargo Wolume

ey

Blements: |= [7] &4 7-Day | Crevved Lander -

v & 7-Day | Crewe Member &

v & 7-Day | Creve Member B

¥l & 7-Day | Crew Member C

v & 7-Day | Crewy Member D

- & 7-Day | Crevved Return Capsule
- [ &8 avtom | Crewed Lander

-

g Cancel

Figure 41. The completed event to move the crew to the return capsule.

21. Click “Add Event” and choose “Flight Transport”
22. Choose the “Crewed Return” flight, check the return capsule, and click “OK” to save the event

E HUEhISIranEporil;

g‘l

[ame: |?-Day | Flight Transport

Mode: o LER ™

Titve: 14.5,:—j days  Priorty: |2 -

Fligghit: ||/ Crewed Return '"

Destination: PAC
Duration: 5.5 days

Capacity: | 0.0/100.0 ky | Caran)

[Cren)

Elements: ] =0 7-Day | Crevwed Lander

vi & T-Day | Crewed Return Capsule
¥l & T-Day | Cres Member &
[¥l & T-Dary | Cresw Member B
v & T-Dary | Cresw Member C
[vi & T-Day | Creww Member D
[1 =0 sutom | Crevved Lander

g Cancel 2-Dec 4Dec 6-Dec 8-Dec 10-Dec

Figure 42. The completed event to
transfer the crew back to Earth.

Date

18-Dec 20-Dec

Figure 43. The mission bat chart illustrating the transport back to

PAC.

23. Click “Add Event” and choose “Remove Elements”
24. Check the Return Capsule and click “OK” to save the event
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o AREmDVEIEETENLE m—i

Matme: |?-Day | Remowve Elementsl |

Moce: | = PAC W™

Tirme: 20,% days Priority:

Elemerts: |5 [v] &0 7-Day | Crewed Return Capsule
¥l & T-Day | Crevy Member &

[V £ 7Day | Crew Member B

] &, T-Day | Cresw Member ©

[vi & T-Day | Crew Member D

i Cancel

Figure 44. The completed event to remove the crew from the simulation.

25. Click “Save” to save the mission

AER

[ s1epaceiNeisdeaard s MRS TanliSCe naniond

File Edit Tools Help

[ET Al Qick Start Scenario 2 ECTTTV T A A sample scneario analyzing the feasibility of & lunar Options: [V
Start Date: ANREpeIE] Data Source: ) quick_sta . Edit (| ' Reload
Created By: Rl Las 1] 1 Ph EST

r @ Metwork rl'iﬂ Mizsions r L) Demands r/ L Manifest r Simulation |
[ Process Bat Chart | Element Bat Chart

| # | Start Date | Mission Name: I
Automated Check-out Miss. .

[ Chart Cption:

Start Date: =
End Date: [

5 Fitter Mizsions
LSP s
[v] automsted Check-out Mission (T3
v 7-Day Surface Exploration (121 M9)

- a

PAC ] Select All | | Deselect Al

| Fitter Evert Types | |
[v] &) Creste Elemerts -
[v] @ Add Resources

[Vl =» Move Elements

|Z =% Transfer Resources
Vi @ Remove Elements
[¥] 58 Reconfigure Element
ksc {|H u vl 58 Reconfigure Group
vl & Demand Resources
[vl & Progulsive Burn

(&

[Z] Draww Elements Waiting (Mull Process)
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Figure 45. A view of the Missions Tab with the scenario bat chart illustrating the flights of the first two
missions.
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Mission 3: Habitat Delivery

The next mission will deliver the Crew Habitat and Power Supply Unit using a cargo lander.

—_

Input the following:
e Name:
e  Start Date:
e Departure Trip:
e Return Trip:

Click the “Add” button under the missions list to create a new mission.

Habitat Delivery

March 1, 2020
From: KSC
From: (blank)

To: LSP
To: (blank)

3. Click “Add Event” at the bottom of the screen and choose “Create Elements”

e Cargo Lander (Catrier)
5. Click “OK” to save the event

Add the following elements from the Element Library:

0.000 m*3 Cargo Volume

— &4 Habit | Cargo Lander

S Crewed Ret

Elements:

=0 Crewed Lander (Carrier)

=0 Crev Habitat (Carrier)
) Powver Supply Unit (Element)

i Remove

o OK ‘ i Cancel

n LreaiesblBrmenis) ﬂ1 E Ci EMEnis: E‘
Name: |Hab'rt|Creale Elements ‘ Mame: |Hah|t|Creata Elemenits: |
Mocle: 4 KSC ™ Mode: Y KsC ™
Time: D,ﬁ days Priority: | 1 hd Time: D,ﬁ days Priotity: | 2 -

rElement Library rElement Library
Create in ‘ ' KSC hd | Create in: ‘L‘II Hahit | Cargo Lander - |
| [0 hd | [ -
1000.0 ky Cargo Mass Julululu}

Crew

_ Cargo Mass

Cargo Volume

=0 Crewved Lander (Carrier)
= Crevved Return Capsule (Carrier)
= Cargo Lander (Carrier)

Elements:

[n.—:h Heakit | Crews Hahitat
 Habit | Poweer Supply Unit

& Crewy hember (Crew Member)

o Add
| g OK || <. Cancel

Figure 46. The completed event to instantiate the

cargo lander vehicle.

Figure 47. The completed event to create a habitat

and power supply unit inside the cargo lander.

Click “Add Event” and choose “Create Elements” again

Change the “Create in” field from “KSC” to “Habit| Cargo Lander”
8. Add the following elements from the Element Library:

e Crew Habitat (Carrier)

e Power Supply Unit (Element)

9. Click “OK” to save the event
10.
11.

12. Click “Save to save the mission

Click “Add Event” and choose “Flight Transport”
Choose the “Cargo Delivery” flight, check the cargo lander, and click “OK” to save the event
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Options: [EsE=i

Start Date: ANREpeIE] Data Source: =)
Created By: Rl

r @ Metwork rl'iﬂ Mizsions r L) Demands r/ L Manifest r Simulation |

# | StertDate Mission Name [ Process Bat Chart | Element Bat Chart
1 Wul1, 2019 Automated Check-out Miss... T 4 |-Chart Option:
2 |Dec,2019 r

Day Surface Exploration Start Date: I@
End Date: [

% | Fitter Missions

[v] automsted Check-out Mission (T3
v 7-Day Surface Exploration (121 M9)
[v] Habitst Delivery (301200

PAC =] Select Al | | Deselect &l

L] | Fitter Event Types | |
[¥] &) Creste Elements -
|Z @ Add Resources
[¥] = Move Elements
[¥] =* Transfer Resources
Vi @ Remove Elements
|Z 53 Reconfigure Element
Ksc ||l | u vl 58 Reconfigure Group
[¥l 57 Demand Resources
[vl & Progulsive Burn hr

[Z] Draww Elements Waiting (Mull Process)
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Figure 48. A view of the Missions Tab with the scenario bat chart illustrating the flights of the first three
missions.
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Mission 4: 14-Day Crewed Mission

This next mission will extend the surface duration from one week to two weeks. Since we have gone through
the work of creating a basic mission, we can simplify the rest of the mission-creation processes by copying
the format for one mission and making small changes.

1. Select the 7-Day Surface Exploration mission and click “Copy”
2. Change the following mission information:
a. Name: 14-Day Surface Exploration
b. Start Date: July 1, 2020
3. Next, we want to move the crew members to the newly-delivered habitat after arrival. Since new
events default to occur immediately after the previously selected event, select the first flight
transport, click the “Add Event” button, choose “Move Elements”
4. Set the “Move to” field to the habitat, check the four crew members
5. Click “OK?” to save the event

= AMOYEIEETEntS a

Mame: |1 4-Dia | Move Elements |

Mode: - LSp w*

I | it

Titne: 7a ] days  Priority: |1 -
Meorve tor | S8 Habit | Crewr Habitat - |

| 0.0 /15000 ky | Cargo Mass

0.000 f 0.000 m*3 Cargo Yollume

Crewy

Elements: |5 ] & 14-Da | Crewed Lander -
[¥ & 14-Da | Crenw Member &
E & 14-Da | Cretwe Member B
[¥ & 14-Da | Crenw Member C
E & 14-Da | Cretwy Member D
- [ S8 14-0a | Crenwed Return Capsule
- [ &4 7-Day | Crewed Lander

[l — W

-

. Cancel

Figure 49. The completed event to move the crew to the habitat.

Select the “Crewed Exploration” event, and click the “Edit” button

Set the Duration to 14 days

Set the Priority to 2 (so the event executes after the crew move to the habitat)

Select the Crew Habitat, check two of the crew members as participating in the EVAs
Finally, click “OK” to save the event

AN
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o . [ save Date
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|
Figure 50. The completed event Figure 51. A view of the Missions Tab after editing the exploration,

expanding the exploration to 14 days. which introduced an error.

Note that at this point, an error message occurs, notifying that the crew member was not found at the Lunar
South Pole (the error message can also be seen by opening the exploration event window). To correct this
error condition, we will edit the timing of the remaining events of the mission.

6. Double-click the time for the Move and change it to 21.50
7. Double-click the time for the Flight Transport and change it to 21.50
8. Double-click the time for the Remove Elements event and change it to 27.00

17 = [B]X]

rﬂ Sy er 25 | e e
File Ecit Tools Help

Options: [BRtY

start Date: [NRREUT] Data Source: Eatt || | & Reload

Created By: Eruaucaii]

() Metwark | 2] wissions | . Demands | LManifest | Simuiation

Name: |14-Day Surface Exploration

Start Dater [Jul 1, 2020 ]|
Deperture Trip Return Trip

From: Wsc ¥ ||| From [ o
Ta: LsP ¥ To. PAC T

Demand Madels:

Everts:

@ |0 Event Mame . a
¢ 000 | 1 14-Da|Create Elements
¢ 000 | 2 14-Da|Create Elements
=]| 000 |z [19-Da|Fight Transport
=¥ 750 |1 14-Da|Move Elements
]| 750 | 2 [14-Da| Crewed Exploration
=+ 2150 | 1 14-Da|Move Elements

2 4. [

L) Add Event || 2 Edit || .4 Remove
2-Jul 4Jul B-Jul B-Jul A0-Jul A2-Jul 14-Jul A6-Jul 18-Jul 20-Jul 22-Jul 24 Jul 26-Jul 28-Jul
[ save Date
[ |
Figure 52. A view of the Missions Tab after the errors have been corrected.

9. Click “Save” to save the mission
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Demand Configuration

Now that the basic mission architecture is set up, we can more closely inspect the feasibility of the scenario
from the demands perspective. First, however, we must add demand generation into the scenarios. This will
be accomplished with two methods: mission-level consumable demands and element-centric sparing. The
mission-level demands will be added to the crewed missions first.

1. Select the “7-Day Surface Exploration” mission and click “Edit”
2. Click the “Add Demand” button and select “Crew Consumables Demand Model”
3. Click “OK” to add the demand model and click “Save” to save the mission

. . : 1 . . : 1]
P e Cons a3 Uspreld Hlueds| a P2 i Cussiiles Uaped o= ﬂ

Maime: ‘Crew Conzsumables Demand Model | Mame: |Crew Consumakles Demand Model| |

Inputs Rates Demands Inputs: Rates Demands |

(Ehe Sl S [— Type Resource Amount Units
© Generic |Generic COS 201 (Water and Support Equip... [113.465 kg
.
IS i Ve R BT o Generic |Generic COS 202 (Food and Support Equip... [58.22 kg
Exploration Duration: days 5 Generic  |Generic COS 203 (Gases) H76.30 kg
© Generic |Generic COS 204 (Hygiene kems) 14.95 kg
[¥] Omit Transtt Demands 5 Generic  |Generic COS 205 (Clothing) HE.10 kg
, P =] @ Generic |Generic COS 206 (Personal tems) 0.00 kg
Transit Duration: days
° Generic |Generic COS 301 (Office Equipment and Su... [20.00 kg
Reserves Duration: 0 j days o (eneric  |Generic COS 302 (Ev'a Equipmert and Con... [457.00 kg
Water Recovery Rate: a2 j % © Generic |Generic COS 303 (Health Equipment and Co... [20.40 kg
© Generic  |Generic COS 304 (Safety Equipment) 23.00 kg
Clathing Litetime 4,':j days o (eneric  |Generic COS 305 (Communications Eguipme... [20.00 kg
© Generic  |Generic COS 306 (Computers and Support ... [20.00 kg
© Generic |Generic COS 701 (Waste) .40 kg
© Generic  |Generic COS 702 (Waste Management Equi... [1.40 kg

Cd Cancel C3 Cancel

Figure 53. The completed inputs for the 7-day Figure 54. The calculated demands for the 7-day
mission demand model. mission.

4. Select the “14-Day Surface Exploration” mission and click “Edit”
5. Click the “Add Demand” button and select “Crew Consumables Demand Model”
6. Click “OK” to add the demand model
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Type Resource AmoLirt Units:
O Generic  |[Generic COS 201 (Water and Support Eguip... [226.93 ki
O Generic  |[Generic COS 202 (Food and Support Eguip... [136.42 ki
O Generic |[Genetic COS 203 (Gases) (352.60 ki
O Generic  |[Generic COS 204 (Hydiene kems) [22.76 ki
o Generic  |[Generic COS 205 (Clothing) 32.20 ki
O Generic  |[Generic COS 206 (Personal fems) d0.00 ki
o Generic  |Generic COS 301 (Office Equipmert and Su... [20.00 ki
o Generic  |[Generic COS 302 (EVA Equipment and Con... |486.00 ki
o Generic  |[Genetic COS 303 (Health Equipmert and Co... 2040 ki
o Generic  |Generic COS 304 (Safety Equipment) 25.00 ki
o Generic  |Genetric COS 305 (Communications Equipme... [20.00 ki
o Generic  |Generic COS 306 (Computers and Support ... [20.00 ki
° Generic  |Generic COS 701 (Wiaste) 2.80 ki
o Generic  |Generic COS 702 (Waste Managerment Equi... [2.80 ki

L Cancel

Figure 55. The completed inputs for the 14-day
mission demand model.

Figure 56. The calculated demands for the 14-day
mission.

Now that the mission-level consumables demands are in place, we will add the element-level spares demands.

This is accomplished by reconfiguring the elements to new operational states that have been assigned demand

models. In this scenatio, the Crew Habitat and the Power Supply Unit have demands for spare parts in their

Active state, and have no demands in their Dormant state. You can view the demand models associated with

each state by opening the Create Elements event where the element was instantiated and selecting “Edit,”

choosing a state, and choosing “Edit State.”

P £ it £l x|

Mame: [Habit | Crew Halitst

leon: | =8 Delivery Truck - | | Reset

Class of Supply |cos 01 Habitstion Facilties - |

Environment: | Unpressurized v Accommodation Mass: _% kg
Mass ?,snn,’:j kg “Yolume: n,’:j m*E

¢ Hahitat Spare (3)

[ Part:

.4 Habitat Dormant

| \;dAddH \;_,Eun” \_',rSe1ln|I|aIH \"gﬁsmuve| |J€AuaH u,ﬁ'EdrIHU%Remuvs|
Cargo Environment: | Unpressurized » Max Crew Size 4,’%
Max Cargo Mass: 1,SUUPj kg Max Cargo Yolime: DPj w3

Figure 57. The edit element dialog for the habitat
element.

ﬂ Wperatipnalisidie E‘
Mame |Habnat Active |

Type: | W) Active hd

Demand Models: | C Habitet Sparing by Mass

Figure 58. The edit state dialog for the habitat's
active state.

7. Select the first Flight Transport, click “Add Event” and choose “Reconfigure Group”
8. Set the new state to be “Active” and check the habitat and power supply elements

9. Click “OK” to save the event

10. Select the “Crewed Exploration” event, click “Add Event” and choose “Reconfigure Group”

11. Set the new state to be “Dormant” and check the habitat and power supply elements

12. Click “OK” to save the event
13. Click “Save” to save the mission
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Ef‘.ﬂ:uufigurs Gy a-‘

Marne: |1 4-Dia | Reconfigure Group |

Mode: 4 LS ™
Tirne: ?.5,':;' days  Priotity: |1 -

MMy Stete:

W) Active hd |

Elemerts:

T
[} & 14-Da | Cresw Member B
(] & 14-Da | Cresy Member
[} & 14-Da | Cresa Member D
-8 140a | Crewved Return Capsule
FO& T-Day | Crewed Lander
~ [ &8 autom | Crevved Lander
~ [0 &9 autom | Crevved Return Capsule
B [ &89 Hakit | Cargo Lander
t [v] =8 Hahit | Crew Habitat

[l 0 Hait | Powver Supply Unit

.5 Cancel

Figure 59. The completed event to turn on the habitat

and

power supply upon arrival.

n;"_ssum’]gurs ST m-'

Mame: |1 4-Da | Reconfigure Grougp |

Mode: | @ LSP ¥
Time; 21 '5;1 days Priarity: |1 -
Nesw State: | W Dormant hd |

Elements: [ &5 14-Da | Crewed Return Capsule a|
[] & 7-Day | Crewed Lander
] &4 sutom | Crevved Lander
] &9 Autom | Crevved Return Capsule
[] &4 Habit | Cargo Lander
[v] S Habit | Crevw Habitst
[ & 14-Da | Cresy Member &
J & 14-Da | Crew Member B
[ & 14-Da | Cresw hember C
[ & 14-Da | Crewy Member D
[¥] £ Habit | Povwer Supply Unit -

.5 Cancel

Figure 60. The completed event to turn off the habitat
and power supply before departure.
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Demands Analysis

After enabling the scenario demands, switch to the Demands Tab. In this module, you can configure the

demands settings before continuing to packing, manifesting, and simulation. There are several visualizations

to aid in the demands analysis.

e Scenario Feasibility — Shows the demands and delivery capability at a node. In the cumulative view,
if the red demands line crosses the green remaining capacity line, the scenario is likely infeasible at

that node. In this scenario, the scenario appeats to be feasible, although a thorough packing and

manifesting analysis is required to account for inefficiencies.
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Scenario Feasibility

— 1

L
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Remaining Capacity — Estimated Demands|

- a

F Demands by Element r Demands by Mission r Demands by Locstion r Commonality Analysis r Repairability Analysis |

Supply Network

riChart Cption:
Feasihility st Mode: LEP w
[Vl Curmulstive Plot  [v] Time Domain

[Vl Legend [Vl Smocth Demands

Filter Supply Edges

[¥] KSC (0.0} - LSP (7.5)

[¥] KSC(153.0) - LSP (160.6)
[¥] KSC (244 .0) - LSP (251 B)
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Select All | | Deselect Al

Fitter Data

[¥] Raw Delivery Capacity
[Vl Remaining Delivery Capacity
[¥] Estimsted Demancs

Select All | | Deselect Al

Figure 61. The scenario feasibility chart provides a quick check for demanded mass and delivery capacity to a

specific location.

e  Supply Network — Illustrates the aggregated demands and transports through the time-expanded
network. The thicker the green line, the more remaining delivery capacity to a location. The larger the

blue dots, the more aggregated demands there are at that point.
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[v] Lakel Angoregated Demands

é 'é [v] Latet Tranzports
s .
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Figure 62. The supply network chart provides a multi-node time-expanded visualization of demands and
delivery capacity.

e Demands by Element, Mission, and Location — Shows the demands broken down by element,
mission, or location. If only one object is selected, the demands are displayed over time.

e Commonality Analysis — If the scenario elements contain common parts, scavenging can be used
to satisty some of the sparing demands.

¢ Repairability Analysis — If the scenario elements contain repairable parts, a trade of crew time can

be made to satisfy some of the sparing demands.
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Packing and Manifesting

After inspecting the scenatio demands, switch to the Manifest Tab. To quickly manifest the demands for

this scenario, we will be using the auto-manifest option.

1.

[ netwerk | E] Missions | - Demands | L Marifest |

| 23 Reset Manifest] | | L] Auto-Manifest |

Agaregated Demands

Supply Po... Resource Amount Packed
LSP373.5)  |Genetic COS 4 (Mai... 11.50 kg 0.00 kg
LSP (373.5)  |Generic COS 4 (Mai... 754 ky 0.00 kg
LSP373.5)  |Genetic COS 201 (... 22693 ky 0.00 kg
LSP(3735) |Generic COS 202(... 13642 ky 0.00 kg
LSP373.5)  |Genetic COS 203 (... 35260 ky 0.00 kg
LSP(3735) |Generic COS 204 (... 2276 ky 0.00 kg
LSP373.5)  |Genetic COS 205 (... 3220kg 0.00 kg
LSP(3735) |Generic COS 206(... 4000 ky 0.00 kg
LSP373.5)  |Genetic COS 301 (... 20.00 kg 0.00 kg
LSP(3735) |Generic COS 302(... 486.00 ky 0.00 kg
LSP373.5)  |Genetic COS 303 (... 2040 kg 0.00 kg
LSP (373.5) |Generic COS 304 2500 ky 0.00 kg
LSP373.5)  |Genetic COS 305 (... 20.00 kg 0.00 kg
LSP (373.5) |Generic COS 306 2000 ky 0.00 kg
LSP373.5)  |Genetic COS 701 (... 280ky 0.00 kg
LSP (373.5)  |[Generic COS 702 ( 280 ky 0.00 kg
LSPC1606)  |(Generic COS 201 (... 11346 ky 0.00 kg
LSP (1606)  |[Generic COS 202 ( 6822 ky 0.00 kg
LSP(1606)  |Genetic COS 203 (... 17630 ky 0.00 kg
LSP (1606)  |[Generic COS 204 ( 1496 ky 0.00 kg
LSP(1606)  |Genetic COS 205 (... 16.10ky 0.00 kg
LSP (1606)  |[Generic COS 206 ( 4000 ky 0.00 kg
LSP(1606)  |Generic COS 301 (... 20.00 kg 0.00 kg

Click the “Reset Manifest” button to reset the aggregated demands

Simulation |
Available Logistics Containers Availsble Carriers
Supply Po... | Container Supply Edge Supply Edge Carrier
LSP [387.5) - PAC(3030)  |14-Da | Crewed Return Cap.
KSC (366.0) - LEP (373.5) 14-Da | Crewed Return Cap.
KSC (366.0) - LSP (373.5)  [14.Da | Crewed Lander
KSC (244.0) - LEP (251 6) Hahit | Cargo Lander
L=P (167 6) - PAC(173.0) 7-Day | Crevwed Return Cap.
KEC 115307 - LSP (160.6) 7-Dary | Cresved Lancer
KSC (153.0) - LSP (160.6) 7-Day | Crevwed Return Cap.
KEC 10.0) - LSP (7 5) Autom | Crewved Return Cap...
KSC(0.0) - LSP (750 Ao | Creweed Lander
Add | ‘ ol Ediit | | R ‘ 3
| d v 9 femove Carriers:
Mame:
Total Mass.
Tatal Volume:
Contents: | Supply Po... Resource Amount )
Contsiners: | Container Mass Volume
Environment:
Cargo Mass: | ‘ Cargo Mass: |
Cargo Volume: | ‘ Cargo Yolume: |

Figure 63. The manifest tab displays a list of aggregated demands, packed demands, and manifested

demands.

2. Click the “Auto-Manifest” button to automatically pack the demands into logistics containers and

manifest the logistics containers onto the first possible flight after the demand (carry-along

preference)

r @Neiwurk |’E§{ Miszions r/ = Demands ruManifes‘t r

||:2Raset Manifest” At Marife: |

Aggregated Demands

Supply Po... Resource Amount Packed |
LSP(373.5)  Generic COS 4 (Mai 11.50 kg
LEP373.5)  |Genetic COS 4 (Mai. 764 kg
LSP (373.5)  |Generic COS 201 ( 22693 ky
LEP373.5)  |Genetic COS 202(... 13642 ky
LSP (373.5)  |Generic COS 203 ( 352 60 kg
LEP373.5)  |Genetic COS 204 (... 2276 kg
LSP (373.5)  |Generic COS 205 ( 3220 kg
LSP(373.5)  |Generic COS 206 (... 40.00 kg
LSP (373.5)  |Generic COS 301 ( 2000 ky
LSP(373.5)  |Generic COS302(... 45600 ky
LSP (373.5)  |Generic COS 303 ( 2040 kg
LSP(373.5)  |Generic COS 304 (... 25.00kg
LSP (373.5)  |Generic COS 305 ( 2000 ky
LSP(373.5)  |Generic COS 306 (... 2000kg
LSP(3735)  |[Generic COS 701 ( 280 kg
LSP(373.5)  |Generic COSTO2(... 280 kg
LSP (1606) |[Generic COS 201 ( 113 .46 kg
LSP(1606)  |Generic COS 202 (... 6822 kg
LSP (1606) |[Generic COS 203 ( 17630 ky
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Figure 64. Auto-manifesting performs a brute-force process to try and manifest the demands.
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Simulation and Analysis

After manifesting the demands, switch to the Simulation Tab.

1. Click the “Simulate” button to run the simulation

2. Under the “Network History” tab, press the play button to run a basic network animation. Pause the
animation near December 25, 2019 and select an element in the right-hand part of the screen, to
inspect its cargo capacity, state, and other information.
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Figure 65. The network history provides a visualization of the scenario network during simulation.

3. Under the “Measures History”, choose the Relative Exploration Capability (REC) measure to track
its evolution over time. Note that this could be improved by creating science elements (COS 6) for

the missions to use the excess cargo margin.
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Figure 66. The measures history provides time histories of the various measures of effectiveness.

4. Under the “Location History”, choose the LSP Node to track its history over time. Deselect COS 8
(Habitation and Infrastructure) and COS 9 (Transportation and Carriers). Note the increase of COS

5 (empty containers) and cycling of demand supply and use.
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Figure 67. The location history provides time histories of the resources located at vatious points.
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